Internet Change of Address (ICOA) Screenshots
Overview of Pages in ICOA

	Screen Number
	Screen Name

	Application Pages

	coa001
	Information About Changing Your Address

	coa002
	Acknowledgement for Change of Address Services

	coa003
	Public Agreement

	coa004
	The Collection and Use of Information from Your Application

	coa006
	Your Information

	coa007
	Your New Address

	coa008
	When Will This Change Happen

	coa009
	Verify Your Information

	coa010
	Confirmation

	coa011
	The Next Person's Turn

	coa012
	Change of Address Survey

	coa013
	Frequently Asked Questions

	Message Pages

	msg051
	Cookies Not Enabled

	msg021
	How to Update Your Address or Telephone Number If You Cannot Change It Online

	msg001
	Internet Security Policy

	msg002
	The Information You Entered Does Not Match Our Records

	msg004
	The Information You Entered Does Not Match Our Records

	msg006
	This Service Is Not Available At This Time

	msg037
	Unable to Process Your Request

	msg008
	We Are Processing Your Request

	msg005
	We Cannot Process Your Request At This Time

	msg007
	You Have Reached the Limit on the Number of Requests

	msg003
	Your Session Has Expired


COA001 Information About Changing Your Address
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g Information About Changing Your Address

You can change your « You get Social Security disabilty, refirement, or survivors benefits,

address andlor  You live in and are moving to an address in one of the 50 states, the Disrict of Columbia, Puerto Rico,
telephone number at the US_ Virgin Islands, Guam, the Northern Mariana Isiands, or American Samoa, and

this web site if: « The address change is for your own benefit or payment

If you have a foreign, APO, or FPO address, see Service Around the World
If you receive Supplemental Security Income, you cannot use this online service.
Ifyou are a Representative Payee, you cannot use this oniine service.

For more information, see the Frequently Asked Questions

What You Will Need « Your complete new address, including zip code. If you don't know your zip code, please check the United
States Postal Service Zip Code directory before continuing
+ Your new phone number or a number we can use to contact you, if this has changed

What To Expect « To protect everyone's privacy, each person who wants to change his or her address must request i
For example, your spouse and other members of your household will need to each log on to do this.
+ You can decide when your change of address will take effect
« There are time limits for your work on each page. You will receive a warning after 25 minutes, and you
will be able to extend your time on the page. After the third warning on a page, you must move to
‘another page or your time will run out, and your work on that page will be lost
« Ifyou have tumed JavaScript off in your browser, you will not receive any warnings.

For more information about the Change Your Address application process, please see the Inernet Security
Policy

Block access to your  If you want to prevent online and automated telephone access to your personal information, you can block
personal information  2ccess fo your personal information

What Do You Wantto | Use my Social Securty password to change my address )
Do?

[ hange my adiess wihou usng a Social Secuty password )





COA002 Acknowledgement for change of Address Services
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g Acknowledgement for Change of Address Services

Any person who knowingly and willingly makes any representation

1. that is false to obtain information from Social Security records, and/or
2. thatis intended to deceive the Social Security Administration as to the true identity of an individual,

could be punished by a fine or imprisonment, or both

I have read the above statement and am the individual to whom the Change of Address information applies.




COA003 Public Agreement
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g Public Agreement

Social Security provides this website for your convenience. You can only use it to change your address or
telephone number.

Social Security is allowed to collect the facts on this form under Section 205 of the Social Security Act. We.
need these facts to quickly identify who you are and provide the information you requested. Giving us these
facts is voluntary. However. without them we may not be able to give you the information that you want. The
Social Security Administration will not use the information for any other purpose. If you want to read more
information on this subject, read The Collection and Use of Information From Your Application

This information collection meets the requirements of 44 U.S.C. 3507, as amended by section 2 of the
Papenwork Reduction Act of 1995. You do not need to answer these questions unless we display a valid
Office of Management and Budget (OMB) control number. The OMB control number for this form is 0960-
0596; expiration date 09/30/2009. We estimate that it wil take about 10 minutes to read the instructions,
gather the facts, and answer the questions. You may send comments on our time estimate above to: SSA,
1338 Annex Building, Baltimore, MD 21235-0001. Send only comments on our time estimate to this
address, not the completed form.

By using this website, you agree to its limitations.




COA004 The Collection and Use of Information from Your Application
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The Collection and Use of Information from Your Application

Although the information you furnish on the application is rarely used for any other purpose than stated, there is  possibiliy thatinformation may be disclosed to another person orto another govemmental agency as
follows: (1) to comply with Federal laws requiring the release of information from Social Security records and (2) a requestfrom a Congressional office or the Office of the President

We may also use the information you give us when we match records by computer. Matching programs compare our records with those of other Federal, State o local goverment agencies. Many agencies may use.
matching programs to find or prove that a person qualifies for benefits paid by the Federal government The law allows us to dothis even if you do not agree to t

Explanations aboutthese and other reasons why information you provide us may be used or given out are available in Social Security Ofices. Ifyou want to leam more about this, contact any Social Security Office.




COA006 Your Information
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fyou are navigating using only the keyboard or using an assistive device and need help, visit our instructionsal page for alterative views and
navigation
Warning: Ifyou select this link, you wil lsave this secure site and go to a new browser window. You will automatically return to this page when you
close the new browser window.

o startyour request, we needto verityyour identi.

Your Social Security Number:

Use your own number even ifyou are recelving benefits 3s 3

‘spouse, child, or parent on another person’s record.

First Name:

Enter Your First Name

WMiddle Initial:

Enter Your Middle Initial

Last Name:

Enter Your Last Name

Suffix: B
‘Select A Suff (any)

Other Last Name:

Date of Birth: EiEe i
Were you born in the United States or its territories = Yes = lo
or possessions?

Place of Birth: B

Ifyes, please select a state, US Territory or Commonwealth from
the drop down list.

Mother's Maiden Name:
(LastName Only)

Irunknown, type “Unknown® or “unk”in the field.

Enter the amount, in whole dollars, of the last )

payment you received from Social Security:

You can find this amount on your most recent bank statement if

You are receiving direct deposit, or on the check itselif you receive

a check by mail

‘Example: Ifthe amount of your last payment was §123.50, the

‘amount you should enter is 123 (do notinclude commas or cents).

Does anyone else in your household also need to = Yes © lio  llot Applicable
report a change of address?

50, that person can sign in after you are finished. Ifyou are

Representative Payee, this online senice will change your

‘address butnot those of the people you represent




COA007 Your New Address

[image: image6.png]Sodial Security Online Change Your Addr

Welcome Roger Field!

Your New Address
Please enter your new address.

Street Address Line 1:
Street Address Line 2:
Street Address Line 3:
Street Address Line 4:
City, State, Zip Code: -

Your New Phone Number
Please enter your new phone number.
Phone Number: « )
If your phone number has not changed, leave blank and select Not
changed
“This phone number is:

Home

Work

Mobile

Attorney
Other

Ihave no telephone number
Not changed
E-Mail Address (Optional):




COA008 When Will This Change Happen
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Letus know how S00n you want this change of address or telephone number to take effect. You can change your address or telephone number now, or up to three months before you move.

When Will This Change Happen

When do you want this change to take effect?

Make the change effective

Ifyou have your check mailedto you, it may take up to 3 weeks to change your address on your benefit check.Ifyou are changing your address
immediately, your next check may still go to your old address.





COA009 Verify Your Information
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Verify Your Information

You are aboutto change your address and/or phone number. Please check the information below to make sure itis correct, It takes up to three business days to change our records. Ifyou wish to submit additional
information or update the information submitted, you cannot make any changes for three business days.

fthe information below is correct, select Confirm'to send your requestto Social Security.

Address:
123 Main Street
Baltimore, MD 21212

Phone: (410) 456-4562 This is your home phone number

Email Address:

Date: This change will take effect on 02/27/2009. Change Date

(Corfim )




COA010 Confirmation
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Confirmation
Thank you Roger Field!
We have received your change of address and/or phone number on February 25, 2009. A confirmation letter from Social Security will be sentto your old address in a few days. If you are changing your address immediately,
‘any notice andlor your next check may stil 9o to your old address. Please also contactthe U.S. Postal Senvice 10 register your change of address,
We suggest that you use your browser commands to print or save this page for your records.

Your new address andlor phone number are listed below.

Address: 123 Main Street
Baltimore, MD 21212
Phone: (410) 456-4562 This is your home phone number
Email Address:
Date: This change will take effect on 02/27/2009.




COA011 The Next Person’s Turn
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The Next Person's Turn

Your change of address andlor phone number has been processed successfuly. You indicated that another person in your household also needs to change his o her address. That person may do so now, or come back
‘another time to give us his or her information.

Does the next person want to do this now? Yes oo




COA012 Change of Address Survey
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Change of Address Survey

We wouldlike to know what you think of this online senice. Please take a minute to fil out our survey below. I you do not wantto fill out the suvey, you may leave this site by using the Finished button below.
Ifyou need addtional information

» Call us at 1-800-772-1213, Monday through Friday between 7 am.and 7 p.m.
‘« Ifyou are deaf or hard-of-hearing, call our toll-free TTY number, 1-800-325-0778, Monday through Friday between 7 am.and 7 p.m.
» Visit your local Social Security Offce.

Was it easy to find the "Change Your Address" Yes o
service from our Home Page?

Was it easy to understand what information you Yes ctio
needed to provide?

Were the instructions easy to understand? Yes cllo
Did we tell you everything you needed to know Yes ctio
about your Change of Address request?

Overall, did you think it was easy to complete your Yes o
request for Change of Address?

Would you do business with us online again based Yes ctio

on your experience today?




COA013 Frequently Asked Questions
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Frequently Asked Questions
‘Why do | need to keep my address and telephone number current?
To ensure prompt delivery of Social Security benefits, SSI payments and correspondence.

What should 1doif I live in another place for part of the year?
You can use this application to change your address any time, even if you relocate for partof the year. For example, if you live in a different place during the summer than you do in the winter —you can change your address
eachtime you relocate.

Iplan on moving in a few weeks, should | wait to change my address?
No, you can feporta future change of adaress.

How will know the change has taken effect?
You willreceive a confirmation screen atthe end of your report notiing you of the effective date of the change. In addition, you willreceive a confirmation letter in the mail

How do| change my address with other government agencies?
‘www.socialsecurity goviotheradaress.tml




MSG051 Cookies Not Enabled
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Cookies Not Enabled

To use this application, you must enable “cookies™ on your computer. We use "session cookies" that we store on your computer only during your visit The session cookie keeps you from losing information youve entered for
‘abusiness transaction with us i, during your vist, you leave our website and return.

‘Once you tum off your computer o stop using the Intemet,the cookie is erased.
To enable cookies, follow the instructions below for the browser you'e using.

Microsoft Internet Explorer 6.0+

‘» Select Intemet Options”from the Tools menu
‘» Click on the Privacy” tab.

‘» Clickthe "Default bution (or manually siide the bar down to “Mediun) under “Setiings".
* Click 0K,

Microsoft Internet Explorer 5.x

‘» Select Intemet Options”from the Tools menu

» Click on the "Security”tab.

« Clickthe “Custom Level” button.

« Scroll down to the “Cookies” section.

‘» Set"Allow cookies that are stored on your computer” to ‘Enable”
‘» Set"Allow per-session cookies™ to "Enable”.

* Click 0K,

Mozilla Firefox (1.0 final release and earlier)

+ Goto the “Tools™ menu.

‘» Select"Options”

« Selectthe "Privacy” icon in the left panel.

‘» Checkthe box corresponding to "Allow sites to set cookies™.
« Click"OK"to save changes

Netscape 7.1/Mozilla 5.0

» Select Preferences” from the Edit menu.

« Click on the arrow nextto "Privacy & Security in the scrolling window to expand.
‘« Under "Privacy & Security, select"Cookies.”

« Select Enable all cookies”.

* Click"OK".

Microsoft Internet Explorer 4.x

‘« Select Intemet Options” from the View menu

+ Click onthe “Advanced tab.

‘« Scroll down to find “Cookies” within the "Security” section
‘» Select"Always accept cookies”

* Click"OK".

Netscape Communicator 4.x

» Select Preferences” from the Edit menu,

‘« Find the "Cookies” section in the "Advanced category.
‘» Select"Accept all cookies” (or "Enable all cookies”).

* Click 0K,

Exit Start Over




MSG021 How to Update Your Address or Telephone Number If You Cannot Change It Online
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How to Update Your Address or Telephone Number If You Cannot Change It Online
Wee sorryyou cannot change your address of telephone number online. You must cal o visitus to change your record. Ifyou are —

inthe United States, you can —
© call us 3t1-800-772-1213 Monday through Friday between 7 am. and 7 p.m.
 call ourtollfree TTY number, 1-800-325-0778, f you are deaf or hard-ofhearing, Monday through Friday between 7 a.m. and 7 p.m., or
© visityour local Social Security office. You can get directions and a map to your local Social Securty office by visiting the Field Office Locator

» outside the United States, you can contact -
© your nearest Social Securiy offce,
0 the closest U.S_ Embassy or consulate, or
 the Veterans Affars Reqional Office (VARO) i the Philippines.

¢ you select any of the links above, you will leave this secure site and go to the copy of these pages on a new browser. You will automatically
return to this page when you close the new browser.

SSAHome




MSG001 Internet Security Policy
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Internet Security Policy
Is it safe to transmit information to the Social Security Administration over the Internet?

SSAis taking all reasonable and proper measures, including encryption, to ensure that your personal information is disclosed only to you. However, the Intemet is an open system and there is no absolute guarantee that
others will notintercept the personal information you have entered or requested and decrypted. Although this possivilly is remote, it does exist.

What is encryption?

Encryption means that allinformation relating to you and your account is scrambled and locked with a mathematical key during the electronic transfer. Most browsers have an icon such as a key or a lockto represent an
encrypted mode or session. A broken key, open lock, or no lock indicates that the session or mode is not encrypted.

Why is special software necessary to access the Internet application?

‘S0 that your online request can remain confidential, SSA uses a securit protocol (method) called Secure Sockets Layer (SSL)for this application. You must use a Web browser that supports SSL. Netscape Navigator and
MicrosoftInternet Explorer are two browsers that support SSL. Using this security protocol, all information sent between your computer and our server is encrypted before being sent on the Intemet.

Why SSL?
‘SSL provides @ high level of security and is the security protocol supported by more browsers than any ofher. s estimated that about 92% of Web browsers have an SSL browser available for their use.
I have the right software and | am trying to connect during your posted business hours, but 1 still cannot access your form. Why?

We have found that a number of business, govemment, and educational networks o not have their firewalls configured to allow passage of secure Web trafic. Check with your systems administratorto determine fthis is
the case atyour sie. Ifthis is the case you will not be able to access this application web site.

Close this window to confinue your request.




MSG002 The Information You Entered Does Not Match Our Records
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Change Your Address

The Information You Entered Does Not Match Our Records
Please check his information

« Ifyoutyped the wrong information, you will needto correct it before continuing.
 Ifthe information is correct, contact Social Security. Be sure to tll the representative that you tried to complete your request online.
To contact Social Security:

» Call our tollree number, 1-800-772-1213. Explain that you are unable to complete your request online. ifyou are deaf or hard of hearing, call our toll-free “TTY" number, 1-800-325-0778. Representafives are available
Monday through Friday from 7 am.to 7 p.m.

‘+ Goto your ocal Social Securiy ofice and tell the representative that you were unable to complete your request
SSAHome




MSG004 The Information You Entered Does Not Match Our Records
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Change Your Address

The Information You Entered Does Not Match Our Records
Ifthe information that you provided is correct, then it may be necessary to correct your Social Security record.

Toresalve the discrepancy:

» Call our tollree number, 1-800-772-1213. If you are deaf or hard of hearing, call our toll-ree “TTY" number, 1-800-325-0778. Representatives are available Monday through Friday flom 7 a.m. 10 7 p.m.
« Call orvisityour local Social Security office.

SSAHome




MSG006 This Service Is Not Available At This Time
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This Service Is Not Available At This Time

This senice is available during the following hours (Eastern Time):

Monday through Friday: 5:00 Al - 1:00 AM
‘Saturday 500 Al - 11:00 PH
‘Sunday 8:00 Al - 10:00 PH
Holidays: 5:00 Al - 11:00 PH

SSAHome




MSG037 Unable to Process Your Request
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Unable to Process Your Request
Ifthe information you gave us is corect, we're sorry but this service is not available to you.

fthe information you gave us is correct and you are currently receiving benefits, online access to your account may be blocked. For assistance, please call us at 1-800-772-1213, Monday through Friday between 7 a.m. and
7p.m.ifyou are deaf or hard-of-hearing, cal our toll-ee TTY number, 1-800-325.0778, Monday through Friday between 7 am. and 7 p.m.

SSAHome




MSG008 We Are Processing Your Request
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MSG005 We Cannot Process Your Request At This Time
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Change Your Address

We Cannot Process Your Request At This Time
We are sorry or he inconvenience, but we cannot process your request at his fime.

Ifyou siillwish to complete your request online, you may try again later. I you want to know about other options for completing this request, you may call 1-800-772-1213 or contact your local Social Security office. Ifyou are
deaf or hard of hearing, cal our toll-ree “TTY" number, 1-800-325-0778. Representatives are available Honday through Friday from 7 am. o 7 p.m.

SSAHome




MSG007 You Have Reached the Limit on the Number of Requests
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Change Your Address

You Have Reached the Limit on the Number of Requests
We have not been able to match the information you entered with our records.

Toresalve the discrepancy:

» Call our tollree number, 1-800-772-1213. If you are deaf or hard of hearing, call our toll-ree “TTY" number, 1-800-325-0778. Representatives are available Monday through Friday flom 7 a.m. 10 7 p.m.
« Call orvisityour local Social Security office.

SSAHome




MSG003 Your Session Has Expired
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Your Session Has Expired
We are sorry for he inconvenience but your session has expired.

Ifyou would ke to continue completing your request online, you may sign in again by selecting the button below.

SSAHome




